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File Menu
The File Menu contains the following Menu Items:

New
Open
Save Song
Save...
Save As...
Merge Song....
Merge MIDI File...
Delete...
Quit

File Formats

The contents of each type of file are as follows:

Song (.SNG)

Tracks used.
Patterns used.
Timebase.
Tempo & Time Signature.
Song Start Time & Frame Format.
Left & Right Locators.
GM & GS Reset switches.
Notepad.

Pattern (.PAT)

Contents of pattern.

Drum Kit (.DRM)

Contents of Drum Kit.

Patch List (.PLS)

Contents of a Patch List.

MIDI (.MID)

Standard MIDI File format, Type 0 or 1.

Definitions (.DEF)

Contains all settings in the MIDI Menu:

Synchronization...
Settings...
Preferences...
Metronome...
Devices...



The file DEFAULT.DEF is saved each time you Quit from the program, and loaded the next 
time you run it, so these settings are preserved between sessions.

Window Layout (.WND)

For Each Window
Size and position.
Caption on / off status.
Whether maximized or minimized.

Transport Window
Auto Return.
Record Mode.
Toggle switches.

Track Window
Visible Columns.
Zoom level.
Pattern Snap.

Piano Roll Window
Horizontal & Vertical Zoom levels.
Grid resolution.
Speaker, MIDI, & Step switches.

Event Window
Note Len.
Ins. Type.
Speaker, MIDI & Step switches.
Display Filters.

Score Window
Resolution.
Note Len.
Speaker, MIDI & Step switches.
Contents of Score Settings Dialog.

Drum Window
Zoom level.
Grid Resolution.
Speaker, MIDI & Step switches.
Visible Columns.

Conductor Window
Zoom Level.
Snap.

Fast Menu Window
Menu Items.

The file DEFAULT.WND is saved each time you Quit from the program, and loaded the next 
time you run it, so these settings are preserved between sessions.



New
This removes the current song from memory - use it when you want to start a new song.



Open
Loads a file from disk. The following file types are allowed:

Song (.SNG)
Pattern (.PAT)
Drum Kit (.DRM)
MIDI File (.MID)
Definitions (.DEF)
Window Layout (.WND)

Each file type has a corresponding radio button on the right side of the Dialog. If you click on
one of these the directory will show files of that type.



Save Song
This is a quick way of saving the Song you are working on. The File Dialog is not displayed - 
the filename of the current song is used so you don't need to tell the program again.

If you try to use this to save an untitled song, the File Dialog will be displayed, but only 
the .SNG file type will be allowed.



Save...
This is where you can save a file you are working on. When you enter the File Dialog, the 
name of the file last accessed is shown and the directory shows only files of that type. You 
can change the file type by clicking on one of the radio buttons at the right side of the 
Dialog.

If you are saving a song, you could use the Save Song function, which is quicker.

If you are saving a MIDI file, you can save either a Type 0 file (a single track) or a Type 1 file 
(two or more tracks). The program checks to see how many tracks contain patterns. If only 
one track contains patterns, it saves a Type 0 file, otherwise it saves a Type 1 file.

If you have several tracks containing patterns, but want to save a Type 0 file, choose Select 
All from the Edit Menu, then Merge Patterns from the Procedures Menu. Delete the old tracks
so only the 'Merged' track remains. Choosing Save... will now save this as a Type 0 file.



Save As...
When you want to save a new file for the first time this is the function to use. You need to 
specify which type of file you want to save, then type in the name in the filename entry at 
the top of the Dialog.

You can also use this to save a file you are working on with a different name, thereby 
copying it.

If you are saving an untitled song, you could use the Save Song function.
If you are saving a MIDI file, you can save either a Type 0 file (a single track) or a Type 1 file 
(two or more tracks). The program checks to see how many tracks contain patterns. If only 
one track contains patterns, it saves a Type 0 file, otherwise it saves a Type 1 file.

If you have several tracks containing patterns, but want to save a Type 0 file, choose Select 
All from the Edit Menu, then Merge Patterns from the Procedures Menu. Delete the old tracks
so only the 'Merged' track remains. Choosing Save As... will now save this as a Type 0 file.



Merge Song...
This allows you to load a song from disk and merge it into the song you are currently 
working on. The tracks of the song being merged are placed at the bottom of the track list, 
so there's no danger of them overwriting the existing tracks.

The tempo and time signature of the original song are not affected, so again there's no 
danger of losing the settings of the piece you are working on.



Merge MIDI File...
This allows you to load a MIDI file from disk and merge it into the song you are currently 
working on. The tracks of the MIDI file are placed at the bottom of the track list, so there's no
danger of them overwriting the existing tracks.

The tempo and time signature of the original MIDI file are not affected, so again there's no 
danger of losing the settings of the piece you are working on.



Delete...
This allows you to delete a file on disk. The File Dialog is displayed and you can choose a 
particular file type if you only want to look at one type of file.



Quit
Choose this when you want to get out of the program.



Edit Menu
The Edit Menu contains the following Menu Items:

Undo
Redo
Copy
Cut
Paste
Clear
Select All
Describe Clipboard...



Undo
Reverses the effect of the last editing operation. For example, if you just used the Transpose 
function (called from any window), Undo will restore the notes to their original pitches.

See also:
Redo.



Redo
Reverses the effect of Undo.



Copy
Copies the selected items to the Clipboard.

See also:
Cut, Paste.



Cut
Copies the selected items to the Clipboard and removes them from the song.

See also:
Copy, Paste.



Paste
Moves the data from the Clipboard to the song. The new items become the selected ones, 
which makes it easy to move them elsewhere if required.

See also:
Copy, Cut.



Clear
Removes the selected items from the song.



Select All
Selects all items in the current window. Selected items are black (except muted patterns 
which change from light grey to dark grey).



Describe Clipboard...
Informs you what data, if any, is currently stored on the Clipboard.



Options Menu
The Options Menu contains the following Menu Items:

Transpose...
Change Velocity...
Change Lengths...
Quantize...
Move Events...
Change Timing...
Delete Events...
Thin Out Continuous Events...

When one of the above is called from the Track Window only the selected pattern(s) will be 
treated. If you have not selected any patterns, all patterns on the selected track will be 
treated.

See also:
Procedures Menu



Transpose...
Allows you to change the pitch of one or more notes. It displays a Dialog where you set the 
number of Semitones, whether the notes will be transposed Up or Down, and the Scope of 
the change.



Change Velocity...
Allows you to change the velocity of one or more notes. It displays a Dialog where you set 
the Amount by which the notes will be changed, and the Scope of the change. You can 
change velocities Up or Down or set all velocities to a Fixed amount. Use the Maximum 
and Minimum settings to limit the change in velocity.



Change Lengths...
Allows you to change the length of one or more notes. It displays a Dialog where you set the 
amount by which the notes will be changed, and the Scope of the change.

The lengths may be changed in the following ways:

By Amount Make notes Longer or Shorter by a definable number of ticks.
Make Legato Change so there are no rests between the notes.
Remove Overlaps Change so notes don't overlap.
Fixed Length Make all notes the same length.



Quantize...
Allows you to change the start positions of one or more notes so they are more regularly 
placed. Notes move forward or backward depending on where the nearest beat or division of
a beat is. A Dialog is displayed where you decide the Quantize Setting (16ths etc.), the 
Percentage by which the notes will be moved, and the Scope of the change.

The percentage setting allows notes to be lightly or heavily quantized. With a Quantize 
Setting of 16ths, a percentage of 50 will make notes move half way to the nearest 16th, 
while 100% will make them move all the way.



Move Events...
Allows you to change the start positions of one or more events. It displays a Dialog where 
you set the number of ticks by which the events will be changed (either Forward or Back).



Change Timing...
Allows you to change the time taken to play a group of events. It displays a Dialog where 
you set the Percentage of the original time for the events to be played in. For example, a 
setting of 50% will result in the notes being played in half the time, while 200% will make 
them play in double the time of the original. All types of event are affected, so a melody line 
with pitch bend will still sound right after having its timing changed - the relative positions of
the notes and pitch bend data will be maintained.



Delete Events...
Allows you to delete one or more events. It displays a Dialog where you choose which types 
of events are to be deleted, and the Scope of the change (for Notes and Polyphonic 
Aftertouch).

If you are deleting Controllers, there are 128 of them to choose from, including Volume, Pan, 
Data Entry etc. Set the Controller Scope to be All or Specific. If deleting a specific 
Controller, use the combobox to choose the one you want to delete.



Thin Out Continuous Events...
Allows you to reduce the density of events such as Modulation, Pitch Bend, MIDI Volume. It 
displays a Dialog where you set the degree of thinning.

If you are thinning Controllers, there are 128 of them to choose from, including Volume, Pan, 
Data Entry etc. Set the Controller Scope to be All or Specific. If thinning a specific 
Controller, use the combobox to choose the one you want to thin out.

Special treatment is given to minimum and maximum values, and centre values for Pan and 
Pitch Bend. These are not removed, ensuring controllers can return to their default positions.



Procedures Menu
The Procedures Menu contains the following Menu Items:

Delete Identical Events
Reverse Notes
Extract Pattern
Merge Patterns

See also:
Options Menu



Delete Identical Events
Allows you to delete events which start at the same position and are identical in all respects.

When this is called from the Track Window only the selected pattern(s) will be treated. If you 
have not selected any patterns, all patterns on the selected track will be treated.

If you call it from an editing window (e.g. Piano Roll or Event) you can define which events 
are treated. If you select a number of events, only those events which are selected will be 
treated. If you have not selected any events, all events will be treated.



Reverse Notes
Allows you to change the start positions of a group of notes so they play in reverse order.

When this is called from the Track Window only the notes in the selected pattern(s) will be 
reversed. If you have not selected any patterns, the notes in all patterns on the selected 
track will be reversed.

If you call it from an editing window (e.g. Piano Roll or Event) you can define which notes are
reversed. If you select a number of notes, only those notes which are selected will be 
reversed. If you have not selected any notes, all notes will be reversed.



Extract Pattern
If you have a pattern containing events on more than one MIDI channel, this function allows 
you to separate the events into individual patterns, each containing a single MIDI channel. 
The new patterns are allocated their own specially created tracks. The original pattern is not 
changed.



Merge Patterns
This function allows you to merge a number of selected patterns into one new pattern, which
is given its own track. The original patterns are not changed.



MIDI Menu
The MIDI Menu contains the following Menu Items:

Synchronization...
Settings...
Preferences...
Metronome...
Devices...

 Patch Lists...



Synchronization...
If you need to make Procyon Pro play in time with an external device, the settings in this 
Dialog can be configured accordingly.

If you're using Procyon Pro as the master clock, you'll need to Send either MIDI Clock or 
MIDI Time Code. If Procyon Pro is to be slaved to an external clock source, you'll need to 
Receive timing information.

The Synchronization Dialog contains separate controls for receiving and sending timing data.
You simply click on the type of sync you need to use and choose the Port to which you've 
connected your MIDI cable. If you use MIDI Clock there's no need to change any of the frame
rate settings or the Song Start time. These are only relevant when MIDI Time Code is being 
used.

If you're using MIDI Time Code, you must make sure Frames per Second is set to the same
as the external device. The Song Start Time defines what time is considered to be the start 
of the song.

Relocate Delay is relevant to both MIDI Clock and MIDI Time Code, but only when Procyon 
Pro is SENDing. When you move the Play Position, Procyon Pro tells the external device to 
get ready to start at that position. Relocate Delay gives the receiving device time to get 
ready. Different devices need different delays, so you'll need to experiment until the two 
machines are working smoothly together - a setting of 500ms is a good starting point. If 
you're not sending sync to an external device, set this value to zero.



Settings...
Timebase defines how many ticks make up one beat. The larger the number, the shorter 
the time between each tick, and the more faithfully real time performances can be recorded 
and played back. However, the PC has to work harder at higher timebases, so if you don't 
need high precision, use a lower value.

Note that if all your patterns are quantized to 16ths, a timebase of 48 will still be 12 times 
finer than you're actually using (there are 6 MIDI clocks in a 16th note and the MIDI clock 
has a timebase of 24: 6 x (48/24) = 12).

Procyon Pro changes its timebase to suit that of any Standard MIDI File (.MID) it loads, so you
can open the Settings Dialog to see what timebase the file is set to.

Message Filters are a set of switches which determine the MIDI message types allowed to 
enter at MIDI In. Remember though that if, for example, you turn on the Pitch Bend filter, 
you won't be able to record any pitch bend!

Channel Filters are another set of switches which allow you to keep out MIDI messages, 
but here you can keep out all message types on any number of the 16 MIDI channels.

Thru Channel Messages is a switch which determines whether channel-based messages, 
such as notes and pitch bend, received at MIDI In are echoed to MIDI Out.

Thru Real Time Messages is a switch which determines whether timing messages are 
echoed to MIDI Out.

Reset Controllers on Stop means that when you stop the sequencer, Procyon Pro sends a 
number of messages on each MIDI channel which do such things as centre pitch bend 
wheels, zero modulation wheels and turn off hanging notes.

Kill Notes on Cycle tells Procyon Pro to turn off any notes which are currently being played 
when the Right Locator is reached (assuming the Cycle switch is on). It prevents unwanted 
notes hanging on when play jumps to the Left Locator.

Chase Events tells Procyon Pro to make sure that when you move the Play Position, 
external MIDI instruments are told what all their settings should be at that point in the song -
program change, pitch bend, modulation wheel etc. - so the song sounds right when you 
restart play.



Preferences...
The Copy Patterns as Parents switch determines the type of pattern created when a 
pattern is copied. If this switch is turned off, copying a pattern results in a Child Pattern 
being created, which is denoted by a dotted border. A Parent Pattern has a solid border.

The Timer Resolution slider allow you to tell the Windows Multimedia Timer how to supply 
timing pulses to Procyon Pro. It determines how many milliseconds will elapse between each 
timer pulse. The finest resolution is 1 ms.

On slower computers lower values will make the Windows Multimedia Timer use a lot of the 
PC's computing power, leaving little available for doing other things. Users with slower 
computers who experience unsteady playback will find it helpful to increase the Timer 
Resolution until playback is steady.
See also:

Track Window.



Metronome...
The Metronome Dialog allows you to tailor the Metronome to your requirements. You can 
have a beep from the PC speaker and / or a click played on an external MIDI instrument.

If you use the MIDI option you can determine separately the notes used by the first beat of 
the bar and by the other beats, plus their velocities.

If you turn on the Record Only switch the metronome operates during recording only. Turn 
this switch off if you want to hear the metronome during playback.

The Count in Bars setting defines how many bars of metronome clicks will be given before 
recording begins.

See also:
Transport Window.



Devices...
If your computer has any MIDI interfaces installed, they will show up in the Devices Dialog. 
You can choose which ones to use by clicking on their names. A device is in use if it is 
selected (white text on a black background). Note that Inputs and Outputs are treated 
separately, so you can, for example, turn off the MIDI Out on the MPU-401 but still use its 
MIDI In.

The devices in use will be shown in the various selectors used in other parts of the program, 
such as the Metronome Dialog and Track Columns.



Patch Lists...
Procyon Pro's Patch List system allows each MIDI instrument connected to your system to 
have its own Patch List to describe the patches available in that instrument.

There are two ways to call up the Patch Lists Dialog.
1. Click in the Patch column in the Track Window. It is the track whose Patch entry is clicked 
on which will be changed.
2. Click on MIDI Menu and choose the Patch Lists... entry. In this case it is the selected 
track's setting which will be changed.

A Patch List file contains:
1. The name of the Instrument (up to 18 characters)
2. A prefix (up to 7 characters)
3. 128 patch names (each up to 18 characters)

The prefix is important because if the track's Patch column simply showed 'Organ', it would 
be impossible to tell which instrument's organ sound was being used, so if an MT-32 was 
receiving on that track's MIDI channel, 'MT32 Organ' would be displayed, as opposed to 'GM 
Organ' or 'U220 Organ'.

The Patch Lists Dialog contains the following:

Current Instrument This combobox contains the names of all patch lists in memory. You 
can choose which instrument's patch list is displayed. Up to 16 patch lists can be held in 
memory.

Instrument Name This edit control allows you to type in a new name for an instrument.

Prefix This edit control allows a new prefix to be entered.

Copy Click this button if you wish to make a copy of the current patch list. You will then be 
able to save it with a new filename.

Add This button lets you load a new patch list from disk.

New Pressing this button starts a new patch list and lets you save it.

Remove This button removes the current patch list from memory. It can be reinstated later 
by pressing the Add button.

Update Files Press this button to save the patch lists, thereby storing any changes 
permanently.

Patch Name This edit control allows you to type a new name for the currently selected 
patch.

Number This shows the number of the currently selected patch. You can type a new number
here as one way of changing patch.

List of Patches This shows the names of all patches in the list. It shows 64 at a time and 
has a horizontal scrollbar which allows you to choose which 64 are visible. Clicking on a 
patch name selects it, copies its name to the Patch Name field and puts its number in the 
Number field. Double-clicking on a name selects it and exits the Dialog as though OK had 
been pressed.



OK This button exits the Dialog and installs the selected patch in the track's Patch column 
and its number in the Prog column.

Set to OFF Click on this button to exit the Dialog and change the Prog setting to OFF.

Routings... Displays the Routings Dialog (see below).

As is usual in Windows Dialog boxes, the Return / Enter key activates the default button. 
Initially this is the OK button, so pressing return closes the Dialog and installs the selected 
patch in the track's Patch column and its number in the Prog column. The Tab key exits the 
current field. This is the key to use if you have typed a new entry and want to keep it but not
exit the Dialog.

Routings Dialog

This provides an easy way of telling the program which instruments are connected to each 
Output Port. Often one Port can be sending MIDI to more than one instrument, so you can 
enter which instrument is in use on each channel. These connections are used by the Patch 
List system to decide which List to display when the Patch Lists Dialog is called up. For 
example, if Track 4 uses Port B, MIDI Channel 7, the system needs to know which instrument 
is connected to Port B and is receiving on Channel 7. The same knowledge is used when the 
text in the Track Window's Patch column is printed. These routings are changed when a new 
instrument is chosen from the Current Instrument combobox in the Patch Lists Dialog. For 
example, if you click on Track 4's Patch column to call up the Patch Lists Dialog and change 
the current instrument, this change is stored by the system and will also show up in the 
Routings Dialog. You do not have to use the Routings Dialog to set the Port-Channel-Patch 
List connections, but it is an easier way of looking at the information, and in ensuring that in 
future the correct Patch Lists are displayed whenever the Patch Lists Dialog is called up.

The Dialog contains the following:

Port A combobox containing all the MIDI Output Ports in use. Use this to choose which Port's
connections are displayed.

Channel Instrument Comboboxes Allow each MIDI Channel in the current Port to be 
'connected' to any of the Patch Lists.

Set All Channels to Button and Combobox provide a quick way of 'connecting' all MIDI 
Channels on a Port to the same Patch List.

The Port-Channel-Patch List connections and the knowledge of which Patch Lists are in use is
stored in .DEF files, so when DEFAULT.DEF is saved on Quit, everything is remembered ready 
for the next session. When you first use Procyon Pro, there will be no DEFAULT.DEF file 
present: this will cause the program to load in 16 Patch Lists by default.

In the Track Window, when you change a track's Channel or Port setting the program also 
updates the Patch column to make sure the correct Patch List is used to show the patch 
name.

The Track Settings and Pattern Settings Dialogs each contain a Patch button. It contains the 
patch name which corresponds to the Program / Port / Channel settings. Pressing it calls up 
the Patch Lists Dialog. Changing the Program, Channel or Port values also updates the patch 
name.



See also:
Track Window.



Windows Menu
The Windows Menu contains the following Menu Items:

Cascade Windows
Tile Windows
Arrange Icons
Close All
Configure Fast Menu...



Cascade Windows
Overlaps all open windows but does not disturb the Transport or Editors Windows.



Tile Windows
Places all open windows side by side but does not disturb the Transport or Editors Windows.



Arrange Icons
Rearranges any icons (minimized windows) on the desktop, starting at the bottom left.



Close All
Closes all windows which are capable of being closed except the Track Window.



Configure Fast Menu...
Displays a Dialog where the contents of the Fast Menu Window can be chosen.

To add a function, click on its name in the Functions list, then click on the Add button. The 
new function will now be visible in the Selections list. You can change the order in which a 
function will appear by clicking on its name in the Selections list, then clicking on the Up or 
Down buttons.

To remove a function from the Selections list, click on its name, then click on Delete.

To remove all functions from the Selections list, click on the Empty button.



Help Menu
The Help Menu contains the following Menu Items:

Contents
Menus
Windows
Keyboard Shortcuts
How to Use Help
About Procyon Pro...
Memory Check...



How to Use Help
Displays the built-in information on using the MS Windows Help system.



About Procyon Pro...
Displays a Dialog with brief details about Procyon Pro.



Memory Check...
Tells you how many Kilobytes of free memory are available in the system.



Transport Window
'Tape Recorder' Controls

Rewind is used to move the Play Position to an earlier one. If used during play, the new 
position will take effect when Rewind is released. If the right mouse button is used to press 
Rewind, the winding speed is three times as fast. If you are working in an editing window 
(e.g. Piano Roll, Event) winding speed is slower in order to give you finer control over the 
Play Position.

Similarly, Fast Forward is used to move to a later position.

Stop does just that - it stops playback or recording.

Play has two functions:
1. It starts playback when the sequencer is not running.
2. It punches out when recording is in progress - the sequencer keeps running but the

record button returns to the off position and any recorded material is displayed.

Record has two functions:
1. It starts recording when the sequencer is not running. Recording is preceded by a 

count in (unless the number of count in bars is set to zero in the Metronome Dialog).
2. It punches in when playback is in progress - the sequencer keeps running but the 

play button returns to the off position. No count in is given in this instance - recording begins
immediately.

Auto Return

This tells Procyon Pro where to send the Play Position when the sequencer stops. There are 
three possible settings:

1. Off - the Play Position stays where it is.
2. Zero - the Play Position goes to the start of the song.
3. Last Start - the Play Position goes to the position from where playback last started.

Record Mode

Click to choose either Replace or Overdub.

Toggle Switches

Synchronization - enables external sync.

Metronome - turns on the metronome click.



Cycle - makes playback and recording cycle between the locators.

Punch - enables automatic Punch In & Out.

Follow Position - makes each window display the current song position.

Conductor - makes playback obey the contents of the Conductor Window.

Edit Solo - plays only the contents of the current edit window.

Relocate Buttons

Return To Zero.

Go To End.

Display Formats

Position bars:beats:ticks.
Time hours:minutes:seconds:frames.
Left Locator bars:beats:ticks. Click on the text 'Left Locator' to jump to its position.
Right Locator bars:beats:ticks. Click on the text 'Right Locator' to jump to its 
position.
Tempo beats per minute.
Time Signature beats per bar / beat time.

Automatic Punch In and Out

This feature is available when the Punch Switch is turned on. During playback, when the Play
Position reaches the Left Locator, Procyon Pro will punch into Record - the Record button is 
'pressed' and the Play button is 'released'. When the Play Position reaches the Right Locator 
the program punches out - the Record button is 'released' and the Play button is 'pressed' 
once again.

See also:
General Window Information, Track Window, 

Conductor Window, Synchronization, MIDI Settings, Metronome.



Editors Window
The eight buttons each open a particular window. If that window is already open, it moves to 
the top of the pile. If it is minimized, it is restored.

1. Track
2. Piano Roll
3. Event
4. Score
5. Drum
6. Conductor
7. Notepad
8. Mixer

See also:
General Window Information, Keyboard Shortcuts.



Track Window

Zoom In - display fewer bars in the same space.

Zoom Out - display more bars in the same space.

Selector

This affects how patterns line up when you move them. For example, if it is set to 'Bar', they 
will 'snap' to the nearest bar.

Displays

1. The Track Display shows the name of each track and various settings associated with it. 
You can choose which settings are visible by changing which Columns are visible. Click on 
any of the column headings and the Select Track Columns Dialog will be displayed. Here you 
can turn columns on and off as required.

To the right of the columns is the Divider. You can drag this left and right so that some or all
of the columns are obscured by the Pattern Display.

Track settings can be changed directly with the mouse or in the Track Settings Dialog.
If you want to give a track a different name, double click on the name and the Track Settings
Dialog is displayed. Here you can type the new name and change any of the settings which 
appear in the Track Columns.

If you click once on a track's name, you can move it up or down to a new position in the 
track list by dragging it with the mouse.

2. The Timeline shows the bars currently being displayed. The width of each bar depends 
on the Time Signature - this can change if there are Time Signature changes defined in the 
Conductor Window. If you click on the timeline with the left mouse button the left locator 
moves to the mouse position: use the right button to reposition the right locator. By clicking 
on the timeline while holding down the CONTROL key, the Play Position will jump to the 
mouse position.

3. The Pattern Display is where the patterns containing your recorded MIDI data are 
displayed. They can be moved, copied, deleted or muted in order to change the structure of 
the composition. Double click on a pattern and the Pattern Settings Dialog is displayed. Here
you can change the Pattern name and any other settings.

Patterns



There are two types of pattern: Parent and Child. A parent has a solid border, a child has a 
dotted border. A child pattern has no events of its own - it plays the events of its parent. It 
also has the same name so you can see which parent it belongs to - all other settings can be
different from the parent, however. A child pattern is created when you copy a parent 
pattern (unless the 'Copy Patterns as Parents' switch is turned on in the Preferences Dialog). 
A child can be placed on the same or a different track from the parent. The illustration above
shows a parent pattern, 'Drums1', which is followed by a child, so the same four bar drum 
pattern will play twice. If you were to change the parent in some way - transpose it for 
example - the child would be affected too as it shares the same events. If you were to delete
the parent, the child would become a parent.

Track Settings

Name Can contain up to 20 characters.
Prog The MIDI Program Number.
Patch Displays the name of the Patch corresponding to the current MIDI Program 
Number.
Bank The MIDI Bank controller value, works in conjunction with the Program Number
to select variations on a sound.
Ch MIDI Channel. Values of 1 - 16 force all patterns on the track to play on the 
specified channel. A value of 0 will play the patterns on the channel(s) on which they were 
recorded.
P Port - one of the MIDI Out ports installed in the PC.
Vol MIDI Volume controller.
Pan MIDI Pan controller.
Rev MIDI Reverb Depth controller.
Chor MIDI Chorus Depth controller.
Vel Velocity modifier - added to all velocities on the track as they are played. A 
negative value reduces velocity. Does not affect the contents of the patterns.
Tran Transpose offset - added to all notes on the track as they are played. A 
negative value lowers the pitch. Does not affect the contents of the patterns.
Time A timing offset. Adds the specified number of clock ticks to the events as they 
are played back. A negative value will make the events play early, a positive one will make 
them play late.

Track Buttons

Mute Prevents any MIDI data from being sent by a track.
Solo MIDI data will be sent from the soloed track ONLY. All other tracks are muted. 
You can still click on the mute buttons to turn muting off if you want to hear other tracks as 
well as the soloed one. When you click on a solo button, the statuses of all the mute buttons 
are stored, so that when solo is turned off the mute buttons return to their previous settings.
If you then solo the SAME track the statuses of the mute buttons return to what they were 
when the track was soloed. If you solo a DIFFERENT track to last time, all mute buttons are 
turned on.
Rec Enables recording on a track. Incoming MIDI messages are rechannelized so 
they are sent from MIDI Out on the channel of the track whose Record button is turned on. If 
the channel is set to zero, the MIDI data is passed through unchanged. MIDI data is not 
echoed to MIDI Out unless the Thru Channel Messages checkbox is enabled in the MIDI 
Settings Dialog.

Selecting Patterns

You can select patterns with either of these two methods:



1. Click on a pattern - it turns black to indicate selection. Click on another one and 
that becomes the selected pattern. If you hold SHIFT and click on a pattern you can toggle 
its status between selected and normal. By using SHIFT clicking you can select several 
patterns.

2. With the left mouse button click on a part of the Pattern Display where there isn't a
pattern. Any selected patterns become deselected. While still holding down the left mouse 
button, drag down and to the right, enclosing patterns in the dotted 'drag rectangle' as you 
go. Release the mouse button. The patterns inside the drag rectangle become selected. This 
method is called lassooing.

Using the Edit, Options & Procedures functions

When using functions from the Edit, Options and Procedures menus, whether patterns are 
affected depends on their selection states. If you have selected one or more patterns, ONLY 
those patterns will be affected. If no patterns are selected, ALL patterns on the selected 
TRACK will be affected.
One method of copying one or more patterns is to select them and use the Copy function 
(Edit Menu) to place a copy of them on the clipboard. You can then Paste them into the 
Pattern Display at the current Play Position.

Moving and Copying Patterns

Selected patterns can be moved and copied. Click on any one of them and drag to a new 
position then let go the mouse button. If you hold down the CONTROL key before you click, a
copy of the patterns will be made at the new position, leaving the originals intact. The newly
copied patterns then become the selected ones.

Local Menu Functions

Add Track Adds a new track at the bottom of the track list.
Copy Track Makes a copy of the selected track including the patterns - the 
child / parent status is determined by the setting in the Preferences Dialog.
Delete Track Deletes the selected track and all the patterns on it.
Delete All Tracks Deletes all tracks and patterns.
Pattern Dimensions... Displays a Dialog where you can type in new start and end 
positions for the selected pattern.
Insert Between Locators Inserts space between the Left and Right Locators.
Delete Between Locators Deletes everything between the Left and Right Locators.

Mouse Tools

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool 
Selector. Move the mouse until the one you want is highlighted. Let go of the right mouse 
button - the selector disappears and the mouse cursor changes to the new shape.

1. The Arrow is at the top left so you can change back to it quickly - click the right button 
and release immediately - there's no need to drag.



2. The Pencil is used for drawing and sizing. You can draw in a new pattern or change the 
size of an existing one. To move the start position of a pattern click on the left half; to move 
the end of a pattern click on the right half. Drag the mouse to the required position and 
release the mouse button.

3. The Eraser is used to delete patterns. Click on a pattern with the eraser and it 
disappears. If you click on one of a group of selected patterns, all the selected patterns are 
deleted.

4. The Mute cursor is used to silence a pattern. Click on a pattern with the mute cursor and 
it turns grey to show it is muted. Click again and it changes back to normal.

5. The Knife is used to slice a pattern in two. The position you click on the pattern 
determines the end position of the first pattern and the start of the second one.

6. The Glue is used to join two patterns on the same track to create one new one which 
starts where the first pattern started and ends where the second one ended. Click anywhere 
on a pattern and it will be glued to the next pattern on the same track.

Multitrack Recording

When the switch is On, you can turn on as many track record (Rec) switches as you wish. 
When the switch is turned Off, the program checks to see if more than one Rec switch is on, 
and makes sure only one is left on (the top one). The Rec switches then behave as usual - 
only one can be turned on. When you turn Rec switches on and off while MIDI notes are 
passing thru, the program monitors your actions and makes sure no stuck notes occur. MIDI 
data is not rechannelized when Multitrack Recording is turned on. It is passed thru 
unchanged, to enable you to correctly hear what is being recorded. The MIDI Indicators show
the MIDI data on the track which matches the MIDI channel of the incoming data, so several 
Indicators may be flashing at the same time. This is useful to see which channels contain 
MIDI data. The Rec switches are also useful to keep out MIDI channels which you do not wish
to hear or record - only data arriving on channels enabled by a Rec switch are passed thru or
recorded.
Overdub and Replace recording modes are both supported during Multitrack Recording.
Several new patterns may be created by Multitrack Recording. All patterns which are newly 
recorded or were overdubbed into are selected to make them easy to see.

GM & GS Reset switches

If the GM Reset switch is On, a GM Reset MIDI message will be sent when playback starts 
from the beginning. Similarly, a GS Reset message will be sent if the GS Reset switch is On.

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can 
then use the Redo function to reverse the effects of the Undo function.

See also:
General Window Information, Transport Window, Conductor Window, Patch Lists, 

Preferences.



Piano Roll Window

Zoom In - display fewer bars in the same space.

Zoom Out - display more bars in the same space.

Vertical Zoom In - display fewer notes in the same space.

Vertical Zoom Out - display more notes in the same space.

Toggle Switches

Speaker Switch - enable sending of selected notes to MIDI Out.

MIDI Edit Switch - enable MIDI Input to edit selected note.

Step Switch - enable Step Time entry.

Buttons

Close the window.

Restore the pattern's original contents.

Selectors

Determines the resolution of the Note Display. This value is also used as the note length in 
Step Time entry.

Determines which events are shown in the Velocity Display.

Displays

1. The Timeline shows the bars and beats currently being displayed. The number of beats 
per bar depends on the Time Signature - this can change if there are Time Signature 
changes defined in the Conductor Window. By clicking on the timeline while holding down 
the CONTROL key, the Play Position will jump to the mouse position.

2. The Information Line shows detailed information about a selected note. You can adjust 
these values with the mouse.



3. The Note Display is a grid where notes are shown as rectangles. The horizontal position 
indicates start time. The width of the rectangle shows the note length.

4. The Velocity Display can contain note velocities, aftertouch, controllers, channel 
pressure and pitch bend. You can edit them with the mouse. Each type of event is shown in a
different colour: the colours are the same as those used in the Event Window.

5. The Screen Keyboard, at the left edge of the window, has four uses:
a) It indicates the pitch of notes in the Note Display.
b) By clicking on it you can play MIDI notes.
c) You can use it to enter notes in step time.
d) It shows notes arriving at MIDI In.

Selecting Notes

You can select notes with either of these two methods:
1. Click on a note - it turns black to indicate selection. Click on another one and that 

becomes the selected note. If you hold SHIFT and click on a note you can toggle its status 
between selected and normal. By using SHIFT clicking you can select several notes.

2. With the left mouse button click on a part of the Note Display where there isn't a 
note. Any selected notes become deselected. While still holding down the left mouse button,
drag down and to the right, enclosing notes in the dotted 'drag rectangle' as you go. Release
the mouse button. The notes inside the drag rectangle become selected. This method is 
called lassooing.

When one note is selected detailed information about it is given in the Information Line. You 
can use the Up and Down arrow keys to move selection to adjacent notes.

Selecting Events in the Velocity Display

Either of the above methods can be used, and the events turn black. If note velocity is being
displayed you can select notes by selecting their velocities.

Using the Edit, Options & Procedures functions

When using functions from the Edit, Options and Procedures menus, whether events are 
affected depends on their selection states. If you have selected one or more events, ONLY 
those events will be affected. If no events are selected, ALL events will be affected. 
Remember though, that in the Options Menu functions the Scope setting may exclude some 
of them.
One method of copying one or more events is to select them and use the Copy function (Edit
Menu) to place a copy of them on the clipboard. You can then Paste them into the pattern at 
the current Play Position.

Moving and Copying Events



Selected events can be moved and copied. Click on any one of them and drag to a new 
position then let go of the mouse button. If you hold down the CONTROL key before you 
click, a copy of the events will be made at the new position, leaving the originals intact. The 
newly copied events then become the selected ones.

Mouse Tools

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool 
Selector. Move the mouse until the one you want is highlighted. Let go of the right mouse 
button - the selector disappears and the mouse cursor changes to the new shape.

1. The Arrow is at the top left so you can change back to it quickly - click the right button 
and release immediately - there's no need to drag.

2. The Pencil is used for drawing and sizing. In the Note Display you can draw in a new note
or change the size of an existing note. To move the start position of a note click on the left 
half; to move the end of a note click on the right half. Drag the mouse to the required 
position and release the mouse button.

You can also draw in the Velocity Display. If any event type except Velocity is chosen as the 
display type, you can use the pencil to draw in new data, a pitch bend curve, for example.

3. The Eraser is used to delete events. It works in both the Note and Velocity Displays. Click 
on an event with the eraser and it disappears. If you click on one of a group of selected 
events, all the selected events are deleted.

4. The Crosshairs cursor is used for modifying existing data in the Velocity Display. Hold 
down the left button and drag the mouse around - if the crosshairs move across any data it 
will change to a new value proportional to the height of the crosshairs in the display. You can
use a single click to change a single value or drag the mouse right and left to reshape a 
controller curve. If Velocity is the display type you can create a crescendo by dragging the 
crosshairs left to right across the velocities, moving up the screen as you go.

5. The Knife is used to slice a note in two. The position you click on the note determines the
end position of the first note and the start of the second one.

6. The Glue is used to join two notes of the same pitch to create one new note which starts 
where the first note started and ends where the second one ended. Click anywhere on a 
note and it will be glued to the next note of the same pitch.

Step Time Entry

The Step Switch must be in the ON position. Single notes and chords arriving at MIDI In are 
recorded at the current Play Position with a length determined by the Grid setting. When you
release the notes on the MIDI keyboard the Play Position advances by the same amount. To 
advance the Play Position without entering a note, press the space bar.



You can also use the Screen Keyboard to enter notes -- click on one of the notes and a note 
of that pitch is recorded. The Play Position doesn't advance automatically, but stays in the 
same place to make it easy to enter successive notes of a chord. Press the space bar to 
advance the Play Position.

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can 
then use the Redo function to reverse the effects of the Undo function.

Changing Pattern

You can change which pattern is being edited by clicking on a different one in the Track 
Window.

See also:
General Window Information, Event Window, Conductor Window.



Event Window
Toggle Switches

Speaker Switch - enable sending of selected notes to MIDI Out.

MIDI Edit Switch - enable MIDI Input to edit selected note.

Step Switch - enable Step Time entry.

Buttons

Close the window.

Restore the pattern's original contents.

Insert an event of the type shown in the Ins Type selector.

Delete the selected event(s).

Make an identical copy of the selected event.

Selectors

Note Length - used in conjunction with the Insert button and in Step Time entry.

Choose the type of event to be added when the Insert button is pressed.

Use the Display Filters to specify which event types are shown. In this example any Notes, 
Program Changes and Pitch Bend will be shown.

The last three column headings change depending on what type of event is first in the list, 
or if any are selected, the type of the first selected event. In this example they are 
describing the Key, Velocity and Length of a note.

You can use the mouse to directly change the values in these columns, plus the event 
position.

Each type of event is shown in a different colour: the colours are the same as those used in 
the Piano Roll Window's Velocity Display.

During playback the left hand column shows a moving arrow which points to the events as 



they are played. If you click in this column while holding down the CONTROL key, the Play 
Position will jump to the mouse position.

Selecting Events

You can select events with either of these two methods:
1. Click on an event's name - it turns black to indicate selection. Click on another one 

and that becomes the selected event. If you hold SHIFT and click on an event you can toggle
its status between selected and normal. By using SHIFT clicking you can select several 
events.

2. Click on an event's name - any selected events become deselected. While still 
holding down the mouse button, drag up or down, selecting more events as you go. Release 
the mouse button when you have selected all you want.

To deselect all selected events, click in the left hand column.

Using the Edit, Options & Procedures Functions

When using functions from the Edit, Options and Procedures menus, whether events are 
affected depends on their selection states. If you have selected one or more events, ONLY 
those events will be affected. If no events are selected, ALL events will be affected. 
Remember though, that in the Options Menu functions the Scope setting may exclude some 
of them.
To copy one or more events select them and use the Copy function (Edit Menu) to place a 
copy of them on the clipboard. You can then Paste them into the pattern at the current Play 
Position.

System Exclusive Editor

This allows you to edit directly the contents of a System Exclusive message. You can move 
the text caret around and type in new values in hexadecimal. To call it up, double click on 
the name of a Sysex event.

Step Time Entry

The Step Switch must be in the ON position. Single notes and chords arriving at MIDI In are 
recorded at the current Play Position with a length determined by the Note Len setting. 
When you release the notes on the MIDI keyboard the Play Position advances by the same 
amount. 

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can 
then use the Redo function to reverse the effects of the Undo function.

Changing Pattern

You can change which pattern is being edited by clicking on a different one in the Track 
Window.

See also:
General Window Information, Piano Roll Window.



Notepad Window
This allows you to include textual information with each song. The contents of the notepad 
are saved in the song file and displayed automatically when a song is loaded.

When you type, word wrapping happens automatically, and you can use the Copy, Cut, 
Paste, Clear, and Undo functions from the Edit Menu. If you use Copy or Cut to place text on 
the clipboard, you won't lose any patterns or events already there.

See also:
General Window Information.



Mixer Window
The Mixer contains 16 
channels, one for each 
MIDI Channel. Each 
channel contains a 
number of controls. To 
transmit MIDI data, click 
on a control and move 
the mouse up or down 
(there's no need to move 
the mouse when you 
click on a button).

At the top of each mixer 
channel is a Flat switch. 
Pressing this sets all 
controls on that channel 
to their default positions. 
You can flatten a single 
knob or slider by clicking 
on it while holding the 
CONTROL key.

Local Menu Functions

In addition to sending data via MIDI Out, the mixer can also respond to data arriving at MIDI 
In and to data contained in a song. The controls move in response to the same messages 
they are capable of sending, so the Volume faders move in response to MIDI Volume data 
and so on. You can decide how the mixer responds with switches in the Define Controls 
Dialog.

The top two knobs (i.e. the red ones) can have their use redefined. Select Define Controls 
and change the values in the Dialog. You can select from several message types and set the 
maximum and minimum values sent when you move the knobs. This Dialog also contains 
the following switches:

Print track names under faders When turned on, the program checks the MIDI channels 
of the tracks and displays the name of a track under the matching mixer channel.

MIDI Input to mixer This allows you to decide whether messages arriving at MIDI In move 
the controls.

Song to mixer This lets you decide whether MIDI messages in the song are sent to the 
mixer controls - if it is turned on the knobs and faders move in real time as the song plays 
the corresponding MIDI messages. They also move when you relocate the Play Position - the 
Chase Events feature in the MIDI Settings Dialog which sends the current values of 
controllers, pitch bend etc. via MIDI also updates the positions of the mixer controls. If the 
Song to mixer switch is turned on part way through a song or MIDI File the controls update 
even if playback has been stopped.

Record mixer moves This switch enables recording of the movements of the knobs and 
faders. Other actions recorded are Flatten Mixer (flatten all the controls in the mixer), 
pressing a channel's Flat button (flatten all a channel's controls), and CONTROL clicking on 



an individual control to flatten it.
When playing back a recording of mixer moves which contains more than one MIDI channel, 
it is best to set the track's channel to 0 (no rechannelization) so the same channels are 
played back. If only one MIDI channel was recorded the track's channel can be assigned to 
that channel or left at 0, whichever is preferred.

To flatten all channels, use the Flatten Mixer function. 

If you execute the Send All Settings command the positions of all the knobs and faders are
sent via MIDI. If you are recording and the 'Record mixer moves' switch is turned on, these 
settings will be recorded. This means a 'snapshot' of the current settings can be recorded. It 
is a good way of storing the Volumes and Pans etc. of a song once you have set them up.

See also:
General Window Information.



Fast Menu Window
This window allows you to choose up to ten menu items and have them visible at all times. A
single mouse click executes the function instead of going via the Menu Bar. Each menu item 
is represented by a button. Pressing that button executes the menu item. You can change 
which menu items appear in the Fast Menu Window in the Configure Fast Menu Dialog.

See also:
General Window Information.



General Window Information
Local Menu

Displays a pop-up menu containing functions relevant to that window.

Window Movement Arrows

Move the window to the left edge of the program window.

Move the window to the right edge of the program window.

Move the window to the top edge of the program window.

Move the window to the bottom edge of the program window.

Make the window use the full width of the program window. A second press returns the 
window to its previous width.

Make the window use the full height of the program window. A second press returns the 
window to its previous height.

Adjusting Values

The left and right mouse buttons are used to change the values displayed in a window as 
follows:

Left Button -1
SHIFT + Left Button -10 (-12 for notes = one octave)
Right Button +1
SHIFT + Right Button +10 (+12 for notes = one octave)

Holding down a mouse button causes the values to change repeatedly until the limit for that 
particular value is reached. To move quickly through the values without using the SHIFT key, 
hold down the opposite mouse button to the one you started with. For example, click on the 
left button to reduce a value in steps of 1. Without taking your finger off the left button, hold
down the right button - the values will start to reduce in steps of 10 (12 for notes). Take your
finger off the right button and the values revert to reducing in steps of 1.

Toggling Caption Bars

Each window has a Caption Bar, which contains its name and sometimes the name of a file 
or pattern. Normally, the Caption Bar is used for moving windows around the screen. You 
may, if you wish, remove a window's Caption Bar in order to increase the amount of screen 
space available for displaying window contents. When the program loads, the Transport and 
Editors Windows are both captionless as they don't need to be moved very often - having 
their captions visible all the time would be a waste of valuable screen space.

To toggle a window's Caption Bar, place the mouse anywhere over the window and press 'W'.



Score Window
Toggle Switches

Speaker Switch - enable sending of selected notes to MIDI Out.

MIDI Edit Switch - enable MIDI Input to edit selected note.

Step Switch - enable Step Time entry.

Buttons

Close the window.

Restore the pattern's original contents.

Switches the Stave Display between Page Preview and Edit.

Selectors

Determines the shortest note and rest drawn in the Stave Display.

This value determines the shape of the Note cursor and is used in Step Time entry.

Displays

1. The Information Line shows detailed information about a selected note. You can adjust 
these values with the mouse.

To the right is a display of the pitch and position (bars:beats:ticks) of the mouse.

2. The Stave Display is where notes are shown on a stave. The clef can be changed in the 
Score Settings Dialog. If you click on an empty part of the Stave Display while holding down 
the CONTROL key, the Play Position will jump to the mouse position.



Selecting Notes

You can select notes with either of these two methods:
1. Click on a note - it turns red to indicate selection. Click on another one and that 

becomes the selected note. If you hold SHIFT and click on a note you can toggle its status 
between selected and normal. By using SHIFT clicking you can select several notes.

2. With the left mouse button click on a part of the Stave Display where there isn't a 
note. Any selected notes become deselected. While still holding down the left mouse button,
drag down and to the right, enclosing notes in the dotted 'drag rectangle' as you go. Release
the mouse button. The notes inside the drag rectangle become selected. This method is 
called lassooing. To continue lassooing notes in later bars, hold the mouse against the right 
edge of the window and the display will flow more notes into the lassoo rectangle.

When one note is selected detailed information about it is given in the Information Line. You 
can use the Up and Down arrow keys to move selection to adjacent notes.

Using the Edit, Options & Procedures functions

When using functions from the Edit, Options and Procedures menus, whether events are 
affected depends on their selection states. If you have selected one or more events, ONLY 
those events will be affected. If no events are selected, ALL events will be affected. 
Remember though, that in the Options Menu functions the Scope setting may exclude some 
of them.
One method of copying one or more events is to select them and use the Copy function (Edit
Menu) to place a copy of them on the clipboard. You can then Paste them into the pattern at 
the current Play Position.

Moving and Copying Notes

Selected notes can be moved and copied. Click on any one of them and drag to a new 
position then let go of the mouse button. If you hold down the CONTROL key before you 
click, a copy of the notes will be made at the new position, leaving the originals intact. The 
newly copied notes then become the selected ones.

Local Menu

Score Settings... Displays the Score Settings Dialog.
Print... Displays a standard Windows Print Dialog.
Print Setup... Displays a standard Windows Print Setup Dialog.

Mouse Tools

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool 
Selector. Move the mouse until the one you want is highlighted. Let go of the right mouse 
button - the selector disappears and the mouse cursor changes to the new shape.

1. The Arrow is at the top left so you can change back to it quickly - click the right button 
and release immediately - there's no need to drag.



2. The Note cursor enters a note with a length specified by the Note Len combobox. The 
pitch and position are calculated from where the mouse button clicks on the stave. These 
values are shown in the Information Line. The Note cursor can also be used to change the 
length of an existing note - the note's length changes to that of the cursor.

3. The Eraser is used to delete notes. Click on a note with the eraser and it disappears. If 
you click on one of a group of selected notes, all the selected notes are deleted.

4. The Glue is used to join two notes of the same pitch to create one new note which starts 
where the first note started and ends where the second one ended. Click on a note and it will
be glued to the next note of the same pitch. This can also be thought of as a means to tie 
two notes.

5, 6. The Sharp and Flat cursors are used for modifying existing notes. One sharpens a 
note, the other flattens it. If the SHIFT key is held down the note changes by an octave, 
otherwise it changes by a semitone.

Step Time Entry

The Step Switch must be in the ON position. Single notes and chords arriving at MIDI In are 
recorded at the current Play Position with a length determined by the Note Len setting. 
When you release the notes on the MIDI keyboard the Play Position advances by the same 
amount. To advance the Play Position without entering a note, press the space bar.

Time and Key Signatures

Different time signatures can be displayed, allowing any changes in the Conductor Window 
to be acted upon when the score is displayed.

Automatic Clef Detection

On entry to the Score Window the program scans the pitches and works out the best clef to 
display the notes on. This also happens when you change pattern by clicking on a new one 
in the Track Window with the Score Window still open. It is not called at any other time, so it 
is still possible to change the clef in the Score Settings Dialog without the program changing 
it back. You can turn Automatic Clef Detection off.

Score Settings Dialog

Margins (points from the edge of the 
screen / page)

Left, Right, Top, 
Bottom

Spacing (points)
Inter-note the horizontal distance between 

notes / rests.
Inter-stave the vertical distance between 

staves.

Text Sizes (points)
Title size of the font used for the song 

title printed at the top of the page.
Names + Bars size of the font used for the patch 



name and bar number.

Clef can be Treble (normal, 8va above, 
8va below), Bass (normal, 8va 
above, 8va below), Treble and 
Bass.

T & B Split Point the lowest note placed on the 
Treble Stave when using the Treble
and Bass clef.

Detect 
Automatically

this switch turns Automatic Clef 
Detection off if required.

Detect Now this button tells the program to 
detect the clef immediately. The 
Stave Display updates if a different
clef is calculated.

Printing
Print Page 
Numbers

the page number will be printed at
the foot of each printed page if 
this is turned on.

Maximum Staves this lets you limit the number of 
staves printed on each page.

Sloping Beams these switches turn this feature on
or off as required.

Screen, Printer

Display Bar 
Numbers

this switch turns on the numbering
of bars and applies to both screen 
and printer.

Using the PC Keyboard

The keys 1 to 7 on the top row of the PC keyboard can be used to change the value in the 
Note Len combobox. The 'D', 'N' and 'T' keys select the dotted, normal or triplet version. If 
the Note cursor is in use, its shape changes.

Printing

The Print function can print anything which can be displayed on the screen. All settings in 
the Settings Dialog apply to printer output. Printing also obeys the settings in the Print 
Dialog - which pages to print, how many copies and whether copies are collated.

Printing can be aborted while the page is being sent to the printer. Press the Cancel button 
to abort printing.

Page Preview

The Page / Edit switch toggles between Page Preview and the normal Edit display. The Page 
Preview display is a scaled version of what will appear on the printed page. The scale 
depends on the window size - on an 800x600 display a better display is possible than on a 
640x480 display thanks to the extra display area available.

The Page number is printed and two arrow buttons are displayed to allow the page to be 



changed - the PgUp and PgDn keys operate these buttons as well as the mouse.

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can 
then use the Redo function to reverse the effects of the Undo function.

Changing Pattern

You can change which pattern is being edited by clicking on a different one in the Track 
Window.

See also:
General Window Information, Conductor Window.



Drum Window

Zoom In - display fewer bars in the same space.

Zoom Out - display more bars in the same space.

Toggle Switches

Speaker Switch - enable sending of selected hits to MIDI Out.

MIDI Edit Switch - enable MIDI Input to edit selected hit.

Step Switch - enable Step Time entry.

Buttons

Close the window.

Restore the pattern's original contents.

Selector

Determines the resolution of the Hit Display. This value is also used as the step advance 
amount in Step Time entry.

Displays

1. The Drum Display shows the name of each drum and various settings associated with it. 
You can choose which settings are visible by changing which Columns are visible. Click on 
any of the column headings and the Select Drum Columns Dialog will be displayed. Here you
can turn columns on and off as required.

To the right of the columns is the Divider. You can drag this left and right so that some or all
of the columns are obscured by the Hit Display.

2. The Timeline shows the bars and beats currently being displayed. The number of beats 
per bar depends on the Time Signature - this can change if there are Time Signature 
changes defined in the Conductor Window. By clicking on the timeline while holding down 
the CONTROL key, the Play Position will jump to the mouse position.



3. The Information Line shows detailed information about a selected hit. You can adjust 
these values with the mouse.

To the right is the name of the current Kit. When the program loads, the GM.DRM Drum Kit 
file loads automatically. This contains the General MIDI Kit.

4. The Hit Display is a grid where notes are shown as coloured LEDs - based on the drum 
machine layout of a row of LEDs which indicate hits. Here, however, different colours are 
used to indicate velocity. The possible colours are: Red, Purple, Blue, Green, Dark Cyan, Dark
Grey, Grey, Light Grey. If a hit is Red, it is at or above the Velocity setting for that drum. If it 
is Purple, it is at or above 10 below the Velocity setting. Each colour change represents a 
further reduction of 10.

Drum Settings

Name Can contain up to 20 characters.
Ch MIDI Channel.
Key MIDI Note associated with this drum.
Vel MIDI Velocity of hits when entered with the large Drum Stick.
Len The length in ticks of the note created when a hit is entered.

Drum settings can be changed directly with the mouse or in the Drum Settings Dialog. If you
want to give a drum a different Name, double click on it and the Drum Settings Dialog is 
displayed. Here you can type the new Name and change any of the settings which appear in 
the Drum Columns. You can also rename the Kit. When you change the Key or Channel of a 
drum, a warning is given if that Key-Channel combination is already in use by another drum. 
It is possible to define a Kit which uses all 16 Channels, and with the same Key used on 
different Channels e.g. E1 used on Ch10 and Ch11 to play Snare Drums on two different 
patches.

If you decide to use more than one Channel (in case more than one synth or synth patch is 
being used for drum sounds), set the channel of the track containing the drum patterns to 0 
so no rechannelization occurs when MIDI is sent.

If you click once on a drum's Name, you can move it up or down to a new position by 
dragging it with the mouse. This makes it possible to change the order of the drums to put 
them in a preferred order, e.g. to put all the Toms together.

Drum Buttons

Mute Prevents any MIDI data from being sent by a drum.
Solo MIDI data will be sent from the soloed drum ONLY. All other drums are muted. You can
still click on the drum buttons to turn muting off if you want to hear other drums as well as 
the soloed one. When you click on a solo button, the statuses of all the mute buttons are 
stored, so that when solo is turned off the mute buttons return to their previous settings. If 
you then solo the SAME drum the statuses of the mute buttons return to what they were 
when the drum was soloed. If you solo a DIFFERENT drum to last time, all mute buttons are 
turned on.



Selecting Drum Hits

You can select hits with either of these two methods:
1. Click on a hit - it turns black to indicate selection. Click on another one and that 

becomes the selected hit. If you hold SHIFT and click on a hit you can toggle its status 
between selected and normal. By using SHIFT clicking you can select several hits.

2. With the left mouse button click on a part of the Hit Display where there isn't a hit. 
Any selected hits become deselected. While still holding down the left mouse button, drag 
down and to the right, enclosing hits in the dotted 'drag rectangle' as you go. Release the 
mouse button. The hits inside the drag rectangle become selected. This method is called 
lassooing.

When one hit is selected detailed information about it is given in the Information Line. You 
can use the Up and Down arrow keys to move selection to adjacent hits.

Using the Edit, Options & Procedures functions

When using functions from the Edit, Options and Procedures menus, whether hits are 
affected depends on their selection states. If you have selected one or more hits, ONLY those
events will be affected. If no hits are selected, ALL hits will be affected. Remember though, 
that in the Options Menu functions the Scope setting may exclude some of them.
One method of copying one or more hits is to select them and use the Copy function (Edit 
Menu) to place a copy of them on the clipboard. You can then Paste them into the pattern at 
the current Play Position.

Moving and Copying Drum Hits

Selected hits can be moved and copied. Click on any one of them and drag to a new position
then let go of the mouse button. If you hold down the CONTROL key before you click, a copy 
of the hits will be made at the new position, leaving the originals intact. The newly copied 
hits then become the selected ones.

Local Menu Functions

Add Drum Adds a new drum at the bottom of the list.
Delete Drum Deletes the selected drum from the list.
Delete All Drums Deletes all drums in the list.

Mouse Tools

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool 
Selector. Move the mouse until the one you want is highlighted. Let go of the right mouse 
button - the selector disappears and the mouse cursor changes to the new shape.

1. The Arrow is at the top left so you can change back to it quickly - click the right button 
and release immediately - there's no need to drag.

2 & 4. The Drum Sticks are used to enter new hits. The large stick enters a hit at the 



Velocity setting for that drum. The small stick enters a hit at a velocity 10 less than the 
Velocity setting. These two sticks therefore allow the entry of two levels of velocity, which 
can be regarded as normal and accented hits. If a stick clicks on an existing hit, it changes 
that hit's velocity.

3. The Eraser is used to delete hits. Click on a hit with the eraser and it disappears. If you 
click on one of a group of selected hits, all the selected hits are deleted.

5 & 6. Velocity Modifiers - The Up arrow increases the velocity of a hit by 10. This would 
make a purple hit red. The Down arrow decreases the velocity of a hit by 10. This would 
make a purple hit blue.

Step Time Entry

The Step Switch must be in the ON position. Notes arriving at MIDI In are recorded at the 
current Play Position with a length determined by the Grid setting. When you release the 
notes on the MIDI keyboard the Play Position advances by the same amount. To advance the 
Play Position without entering a note, press the space bar.

Using the PC Keyboard

The top row of keys on the computer keyboard can be used to play drums. The key on the 
far left plays the selected drum (the one whose name is highlighted) and the next one plays 
the drum below and so on. This makes it possible to play any set of drums simply by 
changing which drum is selected.

You can also use the keys in step time entry. The Play Position doesn't advance 
automatically, but stays in the same place to make it easy to enter successive hits at the 
same position. Press the space bar to advance the Play Position.

The Note and Velocity of a selected hit can be changed by MIDI input or the keys.

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can 
then use the Redo function to reverse the effects of the Undo function.

Changing Pattern

You can change which pattern is being edited by clicking on a different one in the Track 
Window.

See also:
General Window Information, Conductor Window.



Conductor Window

Zoom In - display fewer bars in the same space.

Zoom Out - display more bars in the same space.

Button

Close the window.

Selector

This affects how Conductor Points line up when you move them. For example, if it is set to 
'Bar', they will 'snap' to the nearest bar.

Displays

1. The Information Line shows detailed information about a selected point. You can adjust 
these values with the mouse.

2. The Timeline shows the bars and beats currently being displayed. The width of each bar 
depends on the Time Signature - this can change if there are Time Signature changes 
defined in the Time Signature Display. By clicking on the timeline while holding down the 
CONTROL key, the Play Position will jump to the mouse position.

3. The Time Signature Display is where Time Signature Points are shown. The horizontal 
position indicates time.

4. The Key Signature Display is where Key Signature Points are shown. The horizontal 
position indicates time. 

5. The Tempo Display is where Tempo Points are shown. The horizontal position indicates 
time. The vertical position indicates tempo - the higher the point, the faster the tempo.

Selecting Conductor Points

You can select points in any one of the three displays with either of these two methods:
1. Click on a point - it changes colour to indicate selection. Click on another one and 

that becomes the selected point. If you hold SHIFT and click on a point you can toggle its 



status between selected and normal. By using SHIFT clicking you can select several points.
2. With the left mouse button click on a part of the display where there isn't a point. 

Any selected points become deselected. While still holding down the left mouse button, drag
down and to the right, enclosing points in the dotted 'drag rectangle' as you go. Release the 
mouse button. The points inside the drag rectangle become selected. This method is called 
lassooing.

When one point is selected, detailed information about it is given in the Information Line. You
can use the Up and Down arrow keys to move selection to adjacent points.

Using the Edit functions

When using functions from the Edit menu, whether points are affected depends on their 
selection states. If you have selected one or more points, those points will be affected. If no 
points are selected, none will be affected.
One method of copying one or more points is to select them and use the Copy function to 
place a copy of them on the clipboard. You can then Paste them into the display at the 
current Play Position.

Moving and Copying Conductor Points

Selected points can be moved and copied. Click on any one of the group and drag to a new 
position then let go of the mouse button. If you hold down the CONTROL key before you 
click, a copy of the points will be made at the new position, leaving the originals intact. The 
newly copied points then become the selected ones. Time and Key Signature Points can be 
dragged horizontally only. The first Tempo Point can only be dragged vertically to make sure 
it stays at position 1:01:000. The first Time and Key Signature Points cannot be dragged at 
all for the same reason.

Mouse Tools

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool 
Selector. Move the mouse until the one you want is highlighted. Let go of the right mouse 
button - the selector disappears and the mouse cursor changes to the new shape.

1. The Arrow is at the top left so you can change back to it quickly - click the right button 
and release immediately - there's no need to drag.

2. The Pencil is used for entering new points. Click in the Time Signature, Key Signature or 
Tempo Displays and a new point is added. A warning message is displayed if there is already
a point at that position. Time Signatures must be entered on bar lines in order to make 
musical sense. When you enter a Time Signature, it will be 4/4. If you need to change this, 
click on it to select it, then change its value in the Information Line with the left and right 
mouse buttons. Similarly, a Key Signature starts off as C, so click on it and change it in the 
Information Line to the signature you require.

3. The Eraser is used to delete points. Click on a point with the eraser and it disappears. If 
you click on one of a group of selected points, all the selected points are deleted. The first 
entry in each display cannot be deleted - in order to make musical sense the Conductor 
must contain an initial Tempo, Time Signature and Key Signature.



Playback

During playback the Transport Window shows the changing Tempo and Time Signatures 
providing the Conductor Switch is turned on.

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can 
then use the Redo function to reverse the effects of the Undo function.

See also:
General Window Information, Transport Window.



Keyboard Shortcuts
Action Key(s)
Return to Zero Home
Go to end of last pattern End
External Sync On / Off S
Metronome On / Off M
Cycle On / Off C
Follow On / Off F
Punch In & Out P
Conductor On / Off O
Edit Solo On / Off E
Rewind Left Arrow
Forward Right Arrow
Stop (+ Enter a Rest in Step Time 
entry)

Space

Play Return / Enter
Record +
Jump to Left Locator L
Jump to Right Locator R

Quantize directly (using current 
settings)

Q

Next Page (Score Page Preview) Pg Up
Previous Page (Score Page Preview) Pg Dn
Change Note Len Setting (Score 
Window)

1 to 7, D, T, N

Play Drum Sounds (Drum Window) All keys on the top row

Display Track Window F2
Display Piano Roll Window F3
Display Event Window F4
Display Score Window F5
Display Drum Window F6
Display Conductor Window F7
Display Notepad Window F8
Display Mixer Window F9
Activate Menu Bar F10

Go to next event (Edit Windows) Down Arrow
Go to previous event (Edit Windows) Up Arrow

Insert Event (Event) Insert
Delete / Clear Delete
Undo Alt + Backspace or Ctrl + Z
Redo Shift + Alt + Backspace
Copy Ctrl + Insert or Ctrl + C
Paste Shift + Insert or Ctrl + V
Cut Shift + Delete or Ctrl + X

Open Ctrl + O
Save Song Ctrl + S

Transpose Ctrl + T



Change Velocity Ctrl + H
Change Lengths Ctrl + L
Quantize Ctrl + U
Move Events Ctrl + J
Change Timing Ctrl + I
Delete Events Ctrl + D
Thin Out Continuous Events Ctrl + N

Cascade Windows Shift + F5
Tile Windows Shift + F4
Close a Window Ctrl + F4
Next Window Ctrl + F6
Toggle Caption bar of Window under 
mouse

W

Menu Items

Each Menu contains a number of items used to access various functions. Each item may act directly or 
call up a Dialog Box. Menu Items which are followed by three dots (...) call up a Dialog Box. Others act 
directly.



Clipboard

An area of computer memory used for temporary storage of data.



Scope

The Scope setting allows you to restrict the range of notes which will be treated. For example you may 
want to change only notes From G 2 To C 4. The values are inclusive, so in this example G 2 and C 4 
would be treated as well as all notes between. Alternatively you can choose to treat All notes.

If you call the Options menu function (Transpose etc.) from an editing window (e.g. Piano Roll or Event) 
you can define scope more precisely. If you select one or more notes, only those notes which are 
selected will be treated. This overrides the Scope setting, and the Scope controls in the Dialog are 
disabled. However, if you have not selected any notes, the Scope setting acts just as if you had called it 
from the Track Window.






